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1. General Information 

The UniVert is a precision test instrument designed for the compressive and tensile testing and 
analysis of materials including metals, polymers, and biological specimens. The system includes 
a test station and an integrated software interface to run and analyze test results. 

Environmental and Electrical Specifications 

Electrical Input 100-240VAC, 50-60Hz 

Current Rating 1.67 Amp 

Environmental Conditions Maximum Operating Temperature 25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Data Connections 1 – USB 2.0 for camera/PC communication 

1 – USB 2.0 for controller/PC communication 

System Assembly 

Some basic assembly and setup is required. An unboxing and setup guide can be found in 
Appendix A.  Load cell installation is detailed in Appendix B and software installation is 
described in Appendix C. Camera setup is described in Appendix E. 

Connections to Supply 

Connect power supply into properly grounded 100-240VAC power source to ensure safe 
operation. Ensure that the power cord is easily accessible at all times. The use of an 
Uninterruptible Power Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 
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Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual. 
Operators of this equipment must be instructed in safe operating procedures to prevent injury 
and/or damage. 

 
Ensure that the area around the moving actuator is clear before commencing test protocols. 

 

 

 

The UniVert presents pinch hazard to extremities. Keep hands clear of moving parts for the 
duration of the test. 

 

System Alert 

This equipment must not be disassembled by the user or modified in any way. 

 

Manual Operating Controls 

There is a single power switch on the front of the control unit to turn on the UniVert. 

General Maintenance 

Clean the system as needed with mild soap and water or alcohol based cleaning solutions.  

Approvals and Certification 

This product conforms to applicable CE standards. 
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2. Testing Terminology 

The UniVert is designed to apply uniaxial compressive and tensile forces to a variety of materials. 
This includes metals, plastics, and composites as well as biological materials. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

PreconditioningïEspecially for biological specimens, the goal of preconditioning is to 
restore a specimen to its physiological or in vivo state. During the process of specimen 
storage and preparation, a specimen may swell, dry out, have its material fibers realign, or its 
molecules reorganize. It may take multiple preconditioning cycles for a specimen to be 
restored to its natural state. 

Reproducing Physiological Conditions During Testing - By applying various loads and 
load rates, natural expansion and contraction of a specimen can be reproduced (for example, 
the pulse pressure in an organ). In as much as the physiological conditions can be recreated, 
the specimen can be tested in a more realistic state. 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test 
profiles to best study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

 The entire diagram presents a full test sequence.  

 Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

 Within the first set (preconditioning), two identical test cycles are implemented to bring 
the sample to a satisfactorily preconditioned state.  

 Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose: 

Preloading- Preloads are applied to bring a test 
to a well-defined starting point. Because the 
dimensions of a specimen may change as a 
result of a loading cycle (stretching of fibers, 
viscoelastic effects, plastic deformation, or 
localized material failure at the attachment 
points), the preload adjustment compensates for 
any of these changes in specimen geometry.  

Stretching - During the stretch phase, a 
deformation is applied to the specimen. The 
deformation can be specified either in terms of 
force applied or displacement achieved.  

Holding - The deformation can be held for a given duration. The duration for which it is 
held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to 
the specimen is removed. The duration of the recovery time is configurable and 
dependent on the nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the 
beginning of the next. Some tests may specify a short recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the 
testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement 
control and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
UniVert stretches or compresses the specimen until the predefined displacement is 
achieved. The force required to achieve the displacement is an output of the test. 

Under force control, the force applied to the specimen is predefined. The UniVert 
stretches or compresses the specimen until the predefined force is achieved.  The 
displacement required to achieve the force is an output of the test. 

Control Functions 

The UniVert makes it possible to test specimens under several control functions: 

Under displacement control: 

The true strain function applies the displacement at a true strain rate, which accounts 
for the current specimen length while the specimen is being stretched.  The UniVert 
system approximates this with a series of linear segments (default = 10). 

The ramp function applies the displacement at a constant nominal rate. This is 
equivalent to engineering strain or constant velocity.  

The sine function applies the displacement according to a sinusoid with the desired 
displacement magnitude and duration.  The UniVert system approximates this with a 
series of linear segments. 
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Under force control: 

The step function achieves and maintains the desired force as quickly as possible. The 
amount of time it takes to achieve the desired force depends on the material being tested 
and the force control settings.   

 

       Step 
 
 

Time 

Force 

 

Test Modes 

There are three test modes that can be used when performing a test: tension, compression, and 
3-point bending. 

Tensile Test - This test mode is used in combination with provided specimen grips. In this mode, 
positive displacement is in the direction of increased fixture separation and tension forces are 
positive. 

Compression Test - This test mode is used in combination with provided compression platens. 
In this mode, positive displacement is in the direction of decreased fixture separation and 
compressive forces are positive. 

3-point Bend Test - This test mode uses the same displacement and force convention as 
compression testing but is applied to a 3-point bend setup. 
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3. Software Overview 

The software included with the UniVert device is called UniVert.  It is divided into two modules, a 
data collection module and a review and analysis module.  The data collection module is used to 
set test parameters, enable specimen loading and testing, and monitor test progress.  The screen 
layout for this module is shown below: 

 

 

Test 
Parameters 

 

 

 

 

 

 

Live Force & 
Displacement 

 

 

    Live Video    Live Charting 

The review and analysis module is used to playback accelerated or decelerated test images, 
perform image analysis and tracking, and output movie files for presentation purposes.  The 
screen layout for this module is shown below: 

 

 

Image List 

 

 

 

 

Image 
Playback 

 

Image 
Tracking 

 

Data 
Overlay 
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Output Files and Data Structures 

For each test, the UniVert creates and saves three file types. The following table describes the 
three file types for a project named ñSample1ò. Output from this test would be found in a 
ñSample1ò output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and 
displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to an image captured 
at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2 subfolders.  The ñLogsò subfolder contains a text file of the 
content of the text dialogue portion of the main screen.  It is useful as reference to troubleshoot 
problems with your system, should they occur. 

The ñTrackingò subfolder is initially empty.  If tracking is done on any of the images in the test 
folder using the ñAnalyze and Reviewò software module, there will be data files that contain the 
tracking information stored in this directory.   

While using the ñAnalyze and Reviewò software module, you may create additional data files such 
as text files (*.csv) containing tracking results, images with force data or tracking results overlaid 
(*.wmf), or movie files (*.avi).  These additional files can be stored in the test directory or 
elsewhere on your computerôs hard drive without interfering with the software application (once 
created, they cannot be opened by the UniVert application). 

When working with the data, you should be aware of a few details regarding the data output: 

1. The output specimen size is based on the spacing between the grips or platens and does 
not account for the specimen material outside of the test region. 

2. The software cannot calculate stress since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material 
before or after the test is performed. 

3. Strains can be calculated using the output displacement values (which are based on the 
grip or platen motions). The specimen may actually be subjected to less strain than the 
calculated values due to attachment site effects. The image tracking module is useful for 
determining the actual strain values and variations within the specimen. 
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4. Setting Up & Starting a Test 

Overview 

Setting up and running a new test is a simple process made up of both mandatory and optional 
steps. The following list presents all of the steps, while the rest of this chapter describes each of 
the steps in detail. 

Step 1: Start a New Test 

Step 2: Reset the Actuator 

Step 3: Specify Test Type 

Step 4: Move the Actuator to a Specified Size 

Step 5: Zero the Load Cell (occasional) 

Step 6: Modify the Test Parameters (optional) 

Step 7: Mount the Specimen 

Step 8: Execute the Test 

Step 9: Terminate the Test Prematurely (optional) 

Step 1: Start a New Test 

Launch the UniVert software and then select Collect New from the File menu.  

 

 

 

In the Create Test From Template dialog, perform the following steps: 

1. Select a template that matches the type of test you wish to perform. See the UniVert Tip 
on how to select and use a template. You can modify the template parameters in Step 4, 
below.  

2. Name your test. The dialog will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to 
increment the number at the end of the name. 
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3. If desired, you can change the location of the output data. The location of your output 
data and images is determined by specifying a Test Name and Data Directory. The 
template and data directories are user specific (computer login name). Each system user 
can store their files to a different default location. The system uses the last location 
selected as the default. 

 

UniVert Tip: Selecting and Using Templates 

How to select a template: Designing an appropriate test sequence is an art that 
depends on both the type of material being tested and the specific material properties 
you are interested in measuring. When first testing a new material, you should expect to 
have to experiment with the settings until the test yields meaningful data.  

The system comes loaded with example templates to help you get started. Selecting a 
template does not lock you into a specific test sequence or protocol – rather a template 
defines a test sequence and settings, all of which can be changed before a test is run. 
Once you have developed a test sequence and settings that are appropriate for the 
material you are testing, you should save these settings using “Save As Template” from 
the File menu. You can then select your template the next time you initiate a test. 

Step 2: Reset the Actuator  

We suggest performing a reset at the start of a new test session. This command sends the 
actuator to its fully retracted position and resets the displacement value.  If you have stopped the 
previous test in mid cycle, then you should also reset the actuator. By resetting the actuator, you 
are ensuring that the physical measurements taken by the UniVert are accurate. 

To reset the actuator, select Reset Actuator from the Tools menu, or press  on the toolbar. 

 

System Alert 

You should NOT reset the actuator if the specimen is already loaded in tension. Doing 
so will damage your specimen and/or the load cell. 
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Step 3: Specify Test Type 

Access Test Mode in the Settings menu to select the appropriate test mode and install the 
platens, grips, or 3-point bend attachments (see Appendix D for this procedure). 
 
 

 
 

 

Step 4: Move the Actuator to a Specified Size 

After the actuator has been reset, it will remain in the fully retracted position and must be moved 
to a specified (reference or starting) position.  

To move the actuator to the specified position, select Move Actuator to Specified Size from the 

Tools menu, or press  on the toolbar.  This size may be entered in the ñSpecified Sizeò 
dialogue. 
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Step 5: Zero the Load Cell (occasionally) 

While it is not necessary to zero the load cell with every test sequence, we suggest zeroing the 
load cell at the start of a new test session. With repeated use, the zero point of the load cell can 
drift. By zeroing the load cell, you are ensuring that the force measurements are accurate. 

To zero the load cell, select Zero Load Cell from the Tools menu or press  on the toolbar. 

 

System Alert 

You should zero the load cell after attaching a platen or grip but before mounting a 
sample. If a specimen is already loaded when the load cell is zeroed, the force reading 
will include an offset load. 

 

 

Step 6: Modify Testing Parameters (optional) 

You can select and modify the parameters in the test 
sets by clicking on a row in the Test Sequence table 
and then pressing the Edit Set button (or by double 
clicking on the desired row). When you do so, the Set 
Parameter Editor dialog will appear.  

Note that displacements are specified in either % 
strain, or mm. Force loads are specified in N, and 
durations are specified in seconds. 

The following table describes each of the parameters. 
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Test Parameter Description 

Control Mode Tests are typically performed under displacement control, however, you can select the 
following control modes to achieve specific testing objectives: 

 For creep testing, use force control with a long hold duration. 

 For stress relaxation testing, use displacement control with a long hold 
duration. 

Control Function True Strain or Ramp is typically selected for tests performed in displacement control 
mode. For tests performed in force control mode, Step controls are selected.  

Stretch Magnitude  
(Load Magnitude when in 
Force Control mode) 

Selecting a stretch magnitude is dependent on the material you are testing. A sound 
approach is to begin with a small magnitude and iteratively move up to larger 
magnitudes.  

If you are using Displacement control mode, you can specify the displacement in either 
mm or as a percentage. For example, the displacement on a 5mm specimen can be 
expressed as either 0.5mm or 10%. 

If you are using Force control mode, you can only specify the force in N. 

Watch the test results carefully to determine which magnitude setting best achieves 
your test goals. 

Preload Preload is typically reapplied on every repetition during a preconditioning set as well as 
on the first repetition of a testing set. Specimen size is adjusted after a preload 
adjustment. Strain calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values have been 
suggested, you can set the value accordingly. Otherwise, zero is a good initial choice. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on the material you 
are testing. While Preload can be set at zero, typically you would set the preload 
magnitude somewhere between zero and 10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that is an integer 
multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be used to mimic in 
vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the 
next start to overlie each other. 

Data Output Frequency Typically set to the same frequency as the image output frequency. 

Image Output Frequency Typically set to 1Hz for cycles > 5 seconds and 15 Hz for cycles < 5 seconds. 

 

UniVert Tip: Idle Current 

Idle current (holding current) can be applied to the motors.  The motors have a holding 
force in the de-energized state of approximately 100N.  If forces in excess of 100N are 
expected it is recommended that idle current is used to prevent position loss during 
velocity and direction changes when the motors are de-energized for a very short time.  
When idle current is activated the motors will produce more noise, even when the 
actuator is at rest.  This setting may be accessed by selecting Hardware from the 
Settings menu. 
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Step 7: Mounting a Specimen 

Platen Mounted Specimens 

1. Select an appropriate riser to accommodate the size of the specimen (see Appendix D). 
2. Place the specimen on the bottom platen.  
3. Jog the top platen to the correct position using the jog arrows in Actuator Control 

 

 

Alternately, the Move Actuator to Specified Size  command may be used. 
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UniVert Tip: Compression Specimen Mounting 

Make sure to center the specimen on the platen as much as possible to ensure 
accuracy in the force reading. Ideally, specimens will have two parallel flat sides and will 
make full contact with both platens. Although this is not always possible, flat testing 
surfaces will improve force distribution. 
 

 

Grip Mounted Specimens: 

Low Force Grips 

1. Select an appropriate riser to accommodate the size of the specimen (See Appendix D). 
2. Select a grip with appropriate clamping force for the specimen being tested (see Appendix 

E for more details). 

3. Jog the actuator using Actuator Control or select Move to Specified Size  until the grips 
are sufficiently far apart and attach the specimen to the top grip. 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces.  Release the 
bottom grip. 
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High Force Grips 

1. Select an appropriate riser to accommodate the size of the specimen (See Appendix 
D). 

2. Select a grip with appropriate clamping force for the specimen being tested (see 
Appendix E for more details). 

3. Jog the actuator using Actuator Control or select Move to Specified Size  until the 
grips are sufficiently far apart and attach the specimen to the top grip using the 9/64 
hex key provided. 

 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces. Grip the 
specimen by tightening the grip using the 9/64 hex key again. 
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3-point Bend Specimens 

1. Use the 80mm riser to ensure the sample is in the range of the actuator (see Appendix 
D) 

2. Choose an appropriate sized 3-Point Bend dowel for the type of test you wish to perform. 
3. Install the 3-Point Bending test setup (See Appendix D) 
4. Move the sliders into desired position and lock in place by tightening the M3 fastener to 

the rail. 
5. Place the specimen on top of both lower dowels and begin testing. 
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Step 8: Execute the Test 

Select Execute from the File menu, or press the  button on the toolbar. 

Step 9: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File 
menu. This is preferred over powering down the equipment, as it allows the software to store the 
current actuator position.  

At the end of the completed test (both normally or prematurely terminated) the actuators will 
maintain their current position.  

 

 

 

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while 
handling a load cell: 

 The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating may cause permanent damage to the 
load cell 

 Avoid applying excessive torque and transverse forces to the load cells. Over 
tightening grips or platens onto the active end of the load cell may damage it. 

 Accidently crashing the platens or grips together will produce more force than 
most load cells can handle. Be careful and reduce actuator speed when jogging 
grips or platens close together. 

 Generally avoid dropping, tapping, and exerting unnecessary force to increase 
the life the load cell. 

 

 

 

  

UniVert Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow 
stress calculations to be made from your output data. 
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5.  Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

 

 

 

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time in seconds 

Size (mm) Specimen Gage Length 

Force (N) Load Cell reading 

Displacement (mm) Reports the change in size relative to the initial size 

Compensation (mm) Reports overall compensation due to system stiffness (see Section 8). Off by default. 
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Advanced System Settings Dialogue 

Advanced settings are available by selecting Advanced from the Settings menu.  All of these 
settings are specific to the test template selected. 

True Strain Rate 

Unlike nominal or engineering strain 
rate, a plot of velocity versus time for a 
true strain rate test would be non-linear. 
The degree of non-linearity increases 
with increasing strain. The UniVert 
approximates this non-linear curve with 
a series of linear segments. Typically, 
10 line segments is a sufficiently close 
approximation. More segments can be 
used, but you should bear in mind that 
the actuator velocity can only be 
updated every 250ms. 

Data Averaging 

The load cells are sampled at 100Hz 
with hardware using a central moving 
average of 8 samples. Further data 
averaging can be applied to smooth 
noisy data. 

Force Control Settings 

Force Control Settings affect the rate 
and stability at which forces are 
achieved in force controlled procedures.  
These settings apply to preloads as well 
as Force Control Modes. 

 

Kx (Default = 100, integer values) is a proportional gain tuning parameter.  It controls the 
sensitivity or the amount of corrective action that is applied to the difference between the 
current and target force values. At low gain values the system may be safe and stable but 
may be sluggish in response to changing conditions.  If the proportional gain is increased the 
system becomes more responsive and loads are achieved more quickly.  If Kx is set too high, 
an unstable oscillating system may result and forces may never be achieved. The optimal 
value for these settings depends on the properties of the material being testing.   For stiff 
materials, values may range between 10 and 50.  For soft materials, values may range 
between 50 and 500. 

Tolerance (N) (Default = 0.1) controls how close to the specified force the actual load values 
need to be. For example, a specified force of 10N with a Tolerance of 0.1 N will be 
considered achieved when the loads are between 9.9 and 10.1 N.  Keep in mind the 
accuracy of the load cell being used when choosing the value for this parameter.  The load 
cells typically fluctuate by about 0.1% of their full scale during the course of a test.  For a 10N 
load cell this is about 0.01N but for a 200N load cell, this is about 0.2N.  This value should 
usually be 0.2-0.5% of full scale to ensure stable operation. 

Settling Frames (Default = 5) controls how many successive load samples (sampled at 100 
Hz) need to be within the Tolerance criteria for the force to be considered achieved. For 
example, a specified force of 10N with a Tolerance of 0.1 N and Settling Frames = 5 will be 
considered achieved when the loads are between 9.9 and 10.1 N for 5 successive data 
samples at 100Hz. 
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Velocity (1-10 integer values) matches actuator jog speed.  Typically for stiffer materials, this 
value should be between 6 and 8 and for soft materials, this value should be between 8 and 
10. 

Acceleration (1-10 integer values). Typically this should be set to the default value of 10 
(maximum acceleration).  Changes made to the acceleration will affect tests under both force 
and displacement control.  Reducing this value may help smooth force controlled tests under 
low loads or displacement controlled tests at high speeds.  Tests run with lower accelerations 
will have softer transitions at direction or speed changes but may take longer than specified 
to achieve testing cycles. 

 

UniVert Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the materials you 
are testing.   

To safely test Force Control Settings:  press  
on the tool bar, or from the Tools menu select 
Move Actuators to Specified Load.  The dialogue 
shown on the right will appear.  The UniVert will 
attempt to achieve the specified load (force) but 
will stop when the specified load is reached, the 
actuator has displaced by the maximum 
specified amount, or the timeout time has 
elapsed. 

If the actuator oscillates around the specified 
loads but never achieves them try reducing Kx 
and/or decreasing the velocity. 

 

If the actuator reaches the specified load too 
slowly, try increasing Kx and/or increasing the 
velocity. 

 

 

 

Reset Actuators 

Resetting the actuators with a sample attached may damage the specimen, BioRakes, and/or 
load cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will 
appear after ñReset Actuatorsò is selected, prompting the user to proceed.  This feature can 
be disabled by de-selecting ñShow Warning Before Resetting Actuatorsò. 

 

 

 
  



UniVert User Manual 

23 

 

Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

Soft Limits 

To avoid collisions or sample 
destruction, it is useful to assign 
reasonable travel limits to the 
actuators. This is especially 
important during force control or 
preloading, where if specified loads 
cannot be reached, the actuators 
will keep moving until they reach the 
soft limits. 

Min and Max Displacement, in 
mm, set the minimum and maximum 
positions to which the grips or 
platens are allowed to move.  These 
settings require adjustment 
especially when the riser is 
changed. 

Max Force, in N, sets the maximum 
value of force at which a test will be 
automatically stopped.  The default 
value is set to the capacity of the 
load cells.  Setting this value may be 
useful to prevent sample destruction 
or overloading of the load cells. 

 

 

 

  












































































































































